RDI SXS PRO CHEATSHEET

e This document is set up in two sections: SETUP and PROCESSING (select link to jump ahead)

e For additional troubleshooting information, please consult the SxS Pro

Users Guide in the Help Menu
e For a Video Index of YouTube videos providing more detailed
walkthroughs of midsection measurement procedures, visit the

following link:

Link to USGS Midsection Hydrotube Videos

Help |

About

& Contents.. F1

Fegister Site License...

Register ADCP...

SETUP

Set Units to ‘English’

Processing...

Measurement Wizard... F2

Current Vertical... F7

is  ADCP Port Settings...

F3

Cu:unfigurel‘uriew Tests  Acquire  Playback TDH

0.00
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Units

B

English

Enter ADCP Registration Code into the SxS Software

Help

About
Contents... F1

Register Site License..,

Register ADCP... I

< ADCP Registration >

ADCP seral number Code
1118 2 355d
1335 fo3dde
432 g76180
721 Zhebhd
507 el6fc
3613 57126d

ADCP serial number |

SxS Pro registration code |

Add QK

- Enter ADCP
Serial Number

- Enter SxS Pro
Registration
Code”

- Select ‘Add’

*Registration Code is provided by TRDI after purchasing SxS upgrade for each ADCP.

Set ADCP Communication Port

**If using RioGrande, perform ADCP test and calibrate compass in WinRiver Il prior to connecting in SxS**

Configure | View  Tests  Acquirg

Measurement Wizard... F2
Processing... F3

Current Vertical... F7

|.s ADCP Port Settings..

Units 3

- Enter ADCP COM Port
- Enter ADCP Baud Rate
- Keep Parity and Stop Bit settings

as shown

- Select ‘Test'. ADCP Break

Response should populate in
window

& ADCP Port Settings *

Port parameters

COM port e
Baud rate 115200 o
Parity MNone w
Stop bits 1 w
Response

Test
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https://www.usgs.gov/about/organization/science-support/human-capital/hydrotube-0

Click X to Start a New Measurement

(Can go back to wizard via Configure->Measurement Wizard during measurement as long as pinging stopped. This will allow
for changing of depth and water speed settings based on changes across cross section)

1

Enter Measurement
Information

2

3

Click ‘Check ADCP' to
find instrument. If first
attempt fails, hit 'set
port’ on pop-up
window and select
correct COM port.

4

Set ADCP Depth

(Draft)
5

Ensure Discharge
method is
‘Mid-Section’

6

= MNew Meazurement b4
Measurement information
rement number ]123 Stage J1.82 ft
-
Station number (03508050 Rated Q 237 fi/s
Field crew AM Date | 5/24/2018 -
Recording
Name prefix {03508050
Folder F:\mammis\ﬂ:;mﬂﬂﬁﬂ_lz:i Browse_
Add to name
Measurement number [] Date [] Time Ise delimiter I:_—
Name preview F:\.Measurements‘\ﬂiﬁﬂﬂfﬂﬁﬂj23'\1}351}31]51}_1 23 zxz pdl
ADCP hardware ADCP setup
Instrument StreamPro e | Mok weker denth ]—5_552 ft -
2000 el A Max. water speed 1.640 ft/s
Serial nispber 1721 Water mode Mode 12 e

| Check ADCP Use compass

Select appropriate
‘Velocity Method'.
See below for details
on option. Tagline
Azimuth must be
entered when using
2-D Velocity Method.

Proces [1:Lona ranae available:

Duration fd_lil— SEC Use default cell size and number of cells
CP depth 0.17 f Depth cell size 0.328 ft

Dizcharge method Mid-section | Mumber of cells ]ZD—

Velocity method = 2-D velocity e Commands

Tag line direction ]il':'?— ¥

Wamings

Enter Stage and
Rated Q to calculate
% Q in Verticals

7

Set ‘Max water depth’
and ‘Max Water Speed’
settings for RioGrande
and Strempro ADCPs.
Adjust water mode
settings if necessary.

8

|

- In ice measurement do not use compass unless the electronics is mounted on the s
winter rod appropriately
W

Cancel

*STREAMPRO ONLY*

Select ‘Use compass’
to enable ADCP
compass. “Must
check when using
2-D velocity method
and unchecked for
y-velocity™

Select ‘Long range
available’ if enabled
on ADCP.

Configuration Wizard can be visited during a measurement to change max depth and velocity between verticals.
Beware of Software Bug where ‘Velocity Method’ reverts back to y-velocity when Wizard is re-visited.

Velocity Method Options

1. PREFERRED: Select ‘2-D velocity’ method for software to compute flow angle.
o Must enter tagline (bridge, cableway, etc.) azimuth looking from left to right bank.
o Beware of magnetic interference with compass bearing. Avoid acquiring bearing standing on bridge.
o Requires a calibrated ADCP compass.
e Only enter magnetic variation (in processing window) for tagline azimuths acquired from a map.

Left Bank

Main Flow
Direction

Right Bank
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2. Select ‘Magnitude’ method to manually enter a flow angle or a flow angle coefficient.
o Similar to entering flow angle coefficient for current meter measurements.
e Can also enter flow angle (degrees from perpendicular) .
o Preferred method if magnetic interference is expected or a valid compass calibration is not possible.
o Sign of flow angle (+ or -) does not matter.
3.  ICE: Select ‘y-velocity’ for measurements under Ice.
e Align beam 3 downstream (perpendicular to ‘tagline’) or enter ‘Beam 3 misalignment’ value (The
angle between beam 3 and a line perpendicular to cross-section).
e Sign of misalignment DOES matter for y-velocity method. Looking down on ADCP, beam 3 rotation

from line perpendicular to cross section is positive for clockwise rotation and negative for
counterclockwise rotation.

e Must enter ‘ADCP depth below ice’ or ‘ADCP depth below water surface’ to calculate discharge.

Water surface
(WS)
2 Solid ice ! ' o "r';.
thickness
o . WS to bottom of
thickness solid ice 4 .
:_:"“;“ Ice of slush
ickness ::
r I | + HH | . B
ADCP depth ADCP depth under
Effective undarice Ws
depth R e . v
e i e _______________________D________________________________________
Bottom

Perform Pre-Deployment Tests

e Use ‘Acquire’ menu to ‘Set ADCP Clock’ and to ‘Start Pinging’ in order to verify temperature
stabilization. Document ADCP and verification with 2°C in SVMAQ.

Acquire | Playback Tools Help
e Use ‘Tests’ menu to Conduct ADCP Test and Calibrate Compass. )| SetADCPClock Shift+F4
Start Pinging F4
Tests | Acquire  Playback Tools He Start Edge F6
« ADCP Tests.. Shift+F3 start Vertical P
# Compass Calibration...  Shift+F39 Manual Vertica! -

Select ‘Start’ or ‘F6’ to start pinging

Click 'Start® button to enter starting edge ™ Edge of Water (Vertical 1) >
parameters.
Starting edge (F8 - Toggle)
Start (F) @ Left bank () Right bank
Distance from IP 000 ft
Edge depth 0.000 ft
Velocity comection factor 0.000
o Distance from IP (Initial Point) is location on tagline at edge of
" ( ) & & e
Iver.

e For Triangular/Sloping Edge (most common) enter an Edge depth of 0.00.

o For Vertical Edge, enter Water Depth at Edge and a Velocity Correction Factor that is applied to the velocity
from the next station. For example, if velocity at edge is about half of that of the next station enter 0.5 as
the correction factor.
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Select ‘Next’ or ‘F5’ to proceed to Next Vertical

o Vertical 2 x
Click "'Next' to start collecting vertical data. Velacty profile type Infa
(® Normal (Power/Power)
() Bidirectional {3 pt./ Mo-Slip) e e R ,W /
M et |:F5-:] Fi ) lee {Mo-Slip/No-Slip) ADCP depth 0,170 &
(0) Wind driven {Constant/MNa-Slip)
Flow angle comection 0.000 :
Thresholds Flow angle coefficient 1.000
WT emor velocity 1115 itz Water depth source Bottom track
- Naotes

e Ensure ‘Distance from IP’ is correct and water depth source is ‘Bottom Track'.

o If using ‘Magnitude’ velocity method, enter either the flow angle (in degrees from perpendicular to
tagline) or the flow angle coefficient (from current meter note sheet or angle coefficient protractor).

e Ensure > 30 good ensembles in each vertical. If not enough, software will prompt to collect for longer
period. If still < 30 good ensembles, attempt to change ‘Water depth source’ to ‘Manual’. Enter depth
from ‘good’ ensembles or from another source (sounding weight). Make sure to document the source
and reason for using manual depth in SVMAQ.

o Profile type can be set to reflect expected site conditions, but should stay constant throughout the
measurement.

Review Each Vertical

% Vertical 2
Results
Discharge Q 16.786 fii/s
% Rated Q h.BB %
Mean velocity 1.180 ft/s
Velocity CV |22.3l] %
Direction SD I23. 89 g
Valid ensembles i34
Channel cross-section results i
Total discharge Q 16.786 ftiss
Wamings
Standard deviation of the flow direction is > 20 degrees.
Please stabilize the instrument .

Reject

o Acquire at least 30 good ensembles. If software prompts, consider collecting data for additional time.

e Velocity CV (coefficient of variation) should slowly decrease until reaching a stable value. Velocity CV
compares velocity values from each ensemble and computes the variation as a percentage.

e ‘Direction SD’ may be red if instrument not stable. Common at edges and behind piers. If possible,
stabilize boat by shortening rope length or by adding a weight (high velocity) or windsock (low velocity).

e Ensure ‘% Rated Q' less than 5%. If not, shorten the distance between stations or add station.

® Press Accept to move to next vertical, or Reject to repeat the current vertical.
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Entering a Manual Vertical for Island Edge or Bridge Pier

*NO option for vertical island edge or vertical bridge pier in $xS Pro Software - Recommendation is to End Edge and make a
multi-channel measurement with two $xS measurements*

Acquire | Playback Tools Help
Set ADCP Clock  Shift+F4
Stop Pinging F4
End Edge Fé
Start Vertical F3
Manual Vertical
=3

Enter zero depth and zero velocity for edge of
bridge pier or island edge.

Previous vertical’s velocity is avaliable to
estimate velocity in extreme or rare cases where
velocity data cannot be collected (ie. too shalow),
but can be reasonably estimated.

% Manual Vertical 4

Parameters

Distance from IP

Manual depth

Velocity

Previous verticals velocity

Solid ice thickness

Water surface to bottom of slush

ok ]

Water surface to bottom of solid ice

Select ‘Finish’ or ‘F6’ to Enter End Edge Information

Move to th&_ next vertical and click 'Next’ to -”" Edge of Water (Vertical 38) 4
start collecting data.
.. Ending edge
Next (F5) Finish (F6) Clicking "OK’ button will finish the measurement
Distance from IP iﬁliifl ft
Edge depth [0.000 ft
Velocity comection factor [0.000
Cancel
e Similar options as Starting Edge. If vertical, enter Velocity Correction Factor based on the previous
station.
e Ensure all verticals < 5% total discharge before selecting finish. Cannot add verticals after this step.
POST PROCESSING BACK TO TOP
" 5x5 Pro - Teledyne RD Instruments - [C:\Users\jn “* Processing
File | Configure | View Tests Acquire H
i Measurement Wizard..,. F2 Data screening Speed of sound
xl Processing... F3 By Mark 'Bad’ below bottom @ Lse ADCP value
Vertic Current Vertice?.. F7 * Mark ‘Bad’ below sidelobe () Caleulate for each ping
Dista 3 ADCP Port Settings... Use 3beam solution for BT Use salinity ﬁ]__"
Velog Units 9 Use 3 beam solution for WT () Fixed
e - p— [ Screen depth Use value [1921 260  fss
[] Use weighted mean depth
. . ] Sereen depth using BT velocity
Ensure Processing Settings have not :
changed from wizard. Threstolds Frocessng | |
Processing Window is where power — S pos neference ;‘”c"_ -
. . BT up velo -500 ft#s + Power exponent 0.1667
exponent is set for the entire measurement ° m = i : _
fter determining the correct extrapolation il -t e SR
aner g P Fish interjsty [50 courts Veloctymethod | 2D velocity v
(SEE bEIDW} . . N Good ens. in cell ﬁ_ Tag line direction W °
Increase ‘Good Ensembles in cell’ to 3 to|——— N
remove spikes from near river bed. Increase .
. . Apply Cancel
to 5 if necessary to remove near bed spikes.
If spikes persist, see USGS Hydrotube Video
‘Advanced Review of TRDI SxS Pro \um = = 1A
Data’ for information on evaluating and ey = ™™ .
changing screening thresholds. S ——— e TR B
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o Vertical 12

Double Click on a vertical in the velocity Velokty e ype

contour plot to access the information entered for © Nomal Pone/Pome) | popito

() Bidirectional {3 pt./ No-Slip)

that vertical. The Velocity profile type is adjusted O e (o Sip/No-Si)

here after proper extrapolation is determined o
(see below). Can also access by clicking on each | e
vertical on the ‘view verticals details/selection’

Notes

() Wind driven (Constant/No-Slip)

Info

Al Use in measurement
Distance from [P W ft
ADCP depth Mpyto Al | 0270 &
Flow angle comection W -
Flow angle coefficient IW

I3.28| ft/s Water depth source

display mode.

Velocity [Fos] [Ref: ADCR) 002

oK

Applyto Al | | Composite ~

Velocity [ftis]
=}
5

Depth [f]

kst

“750 1500 2250 3000 3750 4600 5250 6000 B7T.50 7500 B2.50 5000 S7ED 10800 11250 120.00 127:50

Extrapolation

*Qrev cannot directly process measurements from SxS Pro, but can be used to evaluate the velocity profile extrapolation*

In st PI'O | < | 02155500_768

s 5 H Sh Vi
[R— In SxS Pro, Split file e omE T
L Tools Help t t do &« v 4 <« Local Disk (C:) » Measurements > 02153500 768 v @
O create one .p
. . ) 3D Objects A [ Name
BBTalk... file for each vertical
[ I Desktop [ ] 02155500_768.5x5.pd0
o) Opti ons . Documents [7] 02155500_768_000,pd0
— 3 Downlosds 1] 02155500_768_001.pd0
Spﬁt File B Music [ 02155500_768_002.pd0
N, L [ 02155500_768_003.pd0
- | Pictures
sl SAWSC Data Archive L 02155500 768 004pd0
[7] 02155500_768_005.pd0
B videos ¥ cmi
62 itemns

Search 02155500_768

Date modified Type

7172019 11:32 AM - PDOFile
7712019 11:33 AM  PDOFile
7/1/201911:33 AM  PDOFile
7/1/201911:33 AM - PDOFile
7/1/201911:33 AM PDOFile
7172019 11:33 AM  PDOFile
712019 11:33 AM  PDOFile

In WinRiver I

% Select ADCP Raw Data File x
W WinRiver |l - Teledyne RD Instruments Lo [ 02155500 758  @a
s 1 ok in 1 55500_ v 5 -
m In WinRiver ll, create - .
Configure  View  Acquire  Playback Win . ; Name Date modified Type
measurement from data files * [ 02155500_766 55,940 /2019 1132 AM  PDOF
ick access -
Mew Measurement... Ctrl+W : L [ 02155500_768_000.pcl0 7/1/201911:33AM  PDOFil
SE'ECtII‘"Ig all pdD files Except the | 7 02155500_762_001.pcl0 7/1/201911:33 AM  PDOFil
r f + HE ] : i
Cuick MMT... Ctrl+ Q3 0rlg|n3| 5XS. pdo D- [ 02155500_768_002.pd0 T/1/2019 1133 M PDOFi
esktop [ 02155500_768_003.pd0 7/1/201911:33AM  PDOFil
; . ; . [ 02155500_762_004.pdl0 7/1/201911:33 AM  PDOFil
Create Measurement from Data Files... Ctrl+F ™ ] 02155500_768.005.pd0 AT SR O
Libraries [ 02155500_768_006.pdl0 7/1/201911:33AM  PDOFil
Open Measurement Ctrl+ 0 [ 02155500_768_007.pd0 7/1/201911:33 AM  PDOFil
% | 02155500_763_008.pd0d 7/1/201911:33 AM  PDOFil
This BC [ 02155500_768_009.pd0 7/1/2019 1133 AM  PDOFil
A Y mmareran —rn man . —a smman aa mm oae s mmA e
s ° ;
- - — Fil : "02155500_768_000,pd0" "02155500_763_0( ~ 0
Matching Cenfiguration File Mot Found x Metwork 1€ name | =E — | [__Open
Files of type: Data Files (.077; *.PDO) v Cancel
[ Open as read-only

Unable to find matching configuration file, defaults will be

! loaded instead. #*

Ignore Errors and save .mmt file with

— ‘extrap’ in filename.

'n Mrov ‘

"B Main \/ Il SysTest \/ « Compass/P/R\/ & Temp/Sal \\/ B MovBedTst \/ Bl BT \/ GPS \/ l Depth \/

/[ Data \/ Messages \
;, .
Filename Draft |Mumber or Beam 1 ﬁ Draft : x Ekr [::::
(ft) Ensembles = % Invalid (ft:
Apply To: :
03512000_703_00¢ - it 0.00 012
Rrail ® All Transects
03512000_703_001 - 77 0.00 {f) O Transect Only 021
03512000_703_002 - 73 0.00 0.7
03512000_703_003 - n 6.94 Cancel -0.08

Open extrap.mmt in Qrev

Select ‘Depth’ Tab'.

Double click on ‘Draft (ft.)
for any transect.

Enter ADCP depth and select
‘All Transects’
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1)
2)

3)

Extrapolation (continued)

/ @ MovBedTst\/ BlBT \/ G

PS\/ « Depth \/ WT \/ A Extrap \/ Il Edges \/ EDI \

Fit Parameters Fit Settings When Tab Opened

Change ‘Data Type )
Used’ to ‘Manual’
Change ‘Data _—.___:
Type’ to ‘Velocity’ T
Evaluate g
Extrapolation and T SR
record Top, T B
Bottom, and A
Exponent /

*%% 02 04 (G 08 1o 12 e

03512000_703_000

03512000_703_007 . .
- Discharge Sensitivity

Fit Method Automatic
03512000_703_001
03512000_703_002 Top: Constant
03512000_703_003 Bottom: No Sip
03512000_703_004
03512000_703_005 Exponent: 0.4085
03512000_703_006 Reset to These Settings

03512000_703_008
Top  Bottom Exponent % Diff

03512000_703_009

Power Power 0.1667 2934.89

03512000_703_010

Power Power 0.2045 292432

03512000_703_011

Constant No Slip  0.1667 54.72

03512000_703_012

Normalized Velocity

Depth Cel Transects
Data [ Medians
[ Surface Cels O Fic

Start Edge: Left Right

Measurement

Medians

M Fit

Constant No Slip 0.3621 -0.00
03512000 703 013 %
3-Point  No slip  0.1667 -3202.20
Automatic ~
3-Point  No slip 03621 -3256.92
3 Top: Constant
~ | Bottom: No Slp
Exponent:  0.3621

Data Used for Extrap Fitting
'1_ | Manual ~ |

Subsection (5t%:end%):

Threshold (%):

o Based on Qrev, change power exponent in Configure->Processing as shown above (in red text) under ‘Post
Processing’ section above. Close Processing window.
o Double-click on any vertical (as shown above in red text in ‘Post Processing’): Change ‘Velocity Profile
Type’' to Wind Driven if Extrap computes a Constant/No-slip velocity profile and select ‘Apply to all’.
o In cases of extreme upstream flow direction in at least the 3 uppermost bins, Bidirectional profile type may be
used; However, this option should be rarely used. If used, be sure to document site conditions.
o Save file in Qrev to document the extrapolation used for reviewer. (Reviewer: Check ADCP depth entered,
‘Velocity’ type selected, and appropriate extrapolation used)
Save and Export Measurement to . XML
- Sx5 Pro - Teledyne RD Instruments - [C:\Users\; 56 Pro - Teledyne RD Instruments - [C:\Users\jmazurek\Documents\1-W
[ Fite Conf_ig_ure View Tests Acq_uire_ File | Configure View Tests Acquire Playback Tools Helj
T —— " %, New Measurement... Ctrl+W % |
S T ; iy Open Measurement... Ctrl+0Q @@
yl B = Ll I I Save Measurement Ctrl+S | = e
“..J Save Measurement o Ctrl+S J Closi Méssieinet i
Close Measurement ~ *® id  Lock Measurement Ctrl+L 0.751
id Lock Measurement Ctrl+L Create Measurement From Data...
Create Measurement From Data.., - XML Summary File 5 ”IE‘
XML Summary File » CSV Summary File » View Ctri+M
CSV Summary File > ASCI Summary File v I g —
ASCII Summary File r | ASCIl Qutput g 3.00
ASCIl Output Recent Files > I
Recent Files » i
Exit
Import . XML into SVMAQ and Add Any Additional Notes
22 SVMobile i O X ZZ SVMobile - m] x
SensorsQE SensorsQE
DISCHARGE MEASUREMENT ACOUSTIC INFORMATION
IMPORT CHANNEL NEW CHANNEL Instrument Time Synchronized? YES e
Nale QlMeod Qm Time of Synchronization: S@
—— R 220 EDIT Instrument Tested? YES v
DELETE
Import Compass Cal/Eval? YES v
Summarize GPS Unit Used: =
: - <7 Boat/Motor Used: | |@
GH: | & File Type Moving Bed Present? NO ¢
Unshifted Q: 9 x
Temperature/Salinity Readings
2 . This file has been identified as a 5x5 XML file. Would you like
Shifted Q: 0 to continue loading this file? ’ —_— = Acoustic Channel Notes
Rating #: P
CANCEL Yes Mo CANCEL DONE
|

* WARNING: DO NOT load Qrev file into SVMAQ. Only load the XML file exported from SxS Pro Software*
Please Report any Software Bugs/Issues to: gs-w_hawg_all@usgs.gov

BACK TO TOP
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